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1 Safety
1.1 Validity

The chapter “Safety” is valid as instruction manual.
Specific processes and instructions in this document require special precautions to guarantee 
the safety of the operating personnel.

1.2 Symbols used
This document contains information that you must read for your own personal safety and to 
avoid property damage. Depending on the hazard category, the warning signs are displayed in 
descending order as follows:
Safety-relevant symbols

Informative symbols

Action
This symbol indicates a paragraph with instructions.

1.3 Target Group / Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and 
dismounting lies with the system operator.
Mounting, installation, commissioning, operation, maintenance and disassembly of any 
devices may only be carried out by trained, qualified personnel. The instruction manual must 
be read and understood.

1.4 Reference to further documentation
Laws, standards, or directives applicable to the intended use must be observed. In relation to 
hazardous areas, Directive 1999/92/EC must be observed.
The corresponding data sheets, declarations of conformity, EC-type-examination certificates, 
certificates and Control Drawings if applicable (see data sheet) are an integral part of this 
document. You can find this information under www.pepperl-fuchs.com.
Due to constant revisions, documentation is subject to permanent change. Please refer only to 
the most up-to-date version, which can be found under www.pepperl-fuchs.com.

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt devices and any connected facilities or systems, or result in 
their complete failure.

Note!
This symbol brings important information to your attention.
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1.5 Marking

1.6 Intended Use
The devices are only approved for appropriate and intended use. Ignoring these instructions 
will void any warranty and absolve the manufacturer from any liability.
The device must only be operated in the ambient temperature range and at the relative 
humidity (non-condensing) specified.
The device is an intelligent WirelessHART device designed for the transmission of measured 
values from connected C&I or HART devices.
The approved usage of the connected device(s) and gateway can be taken from the 
corresponding parts of their instruction manual.

1.7 Improper Use
Protection of the operating personnel and the overall system is not ensured if the product is not 
being used according to its intended purpose.

1.8 Mounting and Installation
Prior to mounting, installation, and commissioning of the device you should make yourself 
familiar with the device and carefully read the instruction manual.
The device must not be installed at locations where corrosive vapors may be present.
Do not install damaged or polluted devices.
Only use accessories specified by the manufacturer.
Prevent any electrostatic charge that could result in electrostatic discharge while installing or 
operating the device.
If devices have already been operated in general electrical systems, they may subsequently no 
longer be installed in electrical systems used in combination with hazardous areas.
The installation instructions in accordance with IEC/EN 60079-14 must be observed.
Connection or disconnection of energized non-intrinsically safe circuits is only permitted in the 
absence of a hazardous atmosphere.
If "Ex i" protected circuits (intrinsically safe) were operated with non-intrinsically safe circuits, 
they must no longer be used as "Ex i" protected circuits.

WirelessHART® Temperature Converter
WHA-UT-F7B1-0-PP-Z1-Ex2
Pepperl+Fuchs GmbH
Lilienthalstraße 200, 68307 Mannheim, Germany
EC-Type Examination Certificate: IMQ 09 ATEX 008X

 II 2(1)G Ex ia [ia] IIC T4
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The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions 
allow usage of this product before commissioning.

1.9 Housing
To ensure the IP degree of protection:

■ all seals must be undamaged and correctly fitted
■ all screws of the housing and its cover must be tightened with the appropriate torque
■ only cable of the appropriate size must be used in the cable glands
■ all cable glands must be tightened with the appropriate torque
■ all empty cable glands must be sealed or plugged with corresponding plugs

1.10 Operation, Maintenance, Repair
The devices must not be repaired, changed or manipulated.
If there is a defect, the product must always be replaced with an original device.
When the device is in operation, a distance of at least 20 cm must be maintained at all times 
between the device antenna and the body of the user or any other person within the vicinity of 
the measuring point irrespective of application or use.
The housing when energized may be opened for service in Zone 1.
Only use accessories specified by the manufacturer.
The device uses a battery unit containing non-rechargeable, high-power batteries. Please refer 
to the separate battery safety instructions before storing, handling, transporting and disposing 
of the batteries.
Leaking battery acid may cause personal injury and damage to the device.

■ Never use batteries that are leaking.
■ Never use batteries with external damages such as dents or deep scratches, even if no 

battery acid is leaking.
■ Check the battery compartment for battery acid leakage at regular intervals.

Country Guideline
Bulgaria General authorization required for outdoor use 

and public service.
Italy If used outside of own premises, general 

authorization is required.
Japan The device is granted pursuant to the 

Japanese Radio Law and the Japanese 
Telecommunications Business Law.
The device must not be modified (otherwise 
the granted designation number will become 
invalid).

Latvia The outdoor usage of the 2.4 GHz band 
requires an authorization from the Electronic 
Communications Office.

Norway May be restricted in the geographical area 
within a radius of 20 km from the center of Ny-
Alesund.

Rumania Use on a secondary basis. Individual license 
required.
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1.11 Delivery, Transport, Disposal
Check the packaging and contents for damage. 
Check if you have received every item and if the items received are the ones you ordered.
Keep the original packaging. Always store and transport the device in the original packaging.
Always store the device in a clean and dry environment. The permitted storage temperature 
(see data sheet) must be considered.
Disposing of devices, packaging material, and possibly contained batteries must be in 
compliance with the applicable laws and guidelines of the respective country.
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2 Product Specifications
2.1 Introduction

The HART® (Highway Addressable Remote Transducer) communication protocol is used by 
many 4 ... 20 mA transmitters to enable digital communication for diagnosis and maintenance 
purposes. Many device parameters, but also measurement values, can be transmitted digitally 
to and from the device. Until now, HART® technology has mostly been using the wired 
4 ... 20 mA loop as physical layer.
WirelessHART® technology now allows for the wireless transmission of HART® data. To be 
employable worldwide, WirelessHART® technology utilizes the 2.4 GHz Band (IEEE 802.15.4 
wireless network) as physical layer. All WirelessHART devices form a mesh network in which 
every device is not just a measurement point, but also a repeater. This results in a bigger range 
of the whole network as well as an increased reliability through redundant communication 
paths.

Figure 2.1 WirelessHART mesh network

The WirelessHART network is built up, organized and maintained by the WirelessHART 
Gateway and is therefore self-organizing and self-healing. The WirelessHART Gateway also 
takes care for connection to different host systems through different industrial protocol bus 
interfaces.
The WirelessHART Gateway supplies WirelessHART Temperature Converters and 
WirelessHART Adapters with the necessary information for seamless network operation.

1 WirelessHART Temperature Converter
2 WirelessHART Adapter
3 WirelessHART Gateway
4 Fieldbus/Ethernet
5 Host applications

1
2

3

4

5



WHA-UT-F7B1-0-PP-Z1-Ex2
Product Specifications

 20
14

-07

11

2.2 Functional Overview
The WirelessHART temperature converter transmits temperature data from resistance 
thermometers (RTD) or thermocouples (TC) to a WirelessHART gateway via a wireless 
connection. You may also connect slide-wire sensors and mV transmitters
Key Functions

■ Zone 1 servicing/operation: Terminal blocks may be accessed and battery may be 
changed with opened housing cover in Zone 1. The LEDs may be inspected and the 
buttons may be pushed while the device is operating in Zone 1.

■ Physical interfaces for RTD and TC
■ LEDs for supply status, communication status and device status indication
■ Battery life estimation and "Low Battery" alarm (DTM functions)

2.3 Scope of Delivery
The standard scope of delivery of the WirelessHART temperature converter includes:

■ WirelessHART Temperature Converter WHA-UT-F7B1-0-PP-Z1-Ex2
If ordered, the following accessories:

■ Lithium battery W-BAT-B1-Li mandatory for use in connection with hazardous areas
■ Mounting set W-ACC-F7MK
■ Pt100 sensor for external cold junction compensation W-ACC-CJC

2.4 Design
Controls and Indicators
The buttons and LED indicators can be accessed without opening the housing.

Figure 2.2 Controls and indicators

1 Button A
2 Button B
3 Red FLT LED
4 Yellow COM LED
5 Green PWR LED

1

2

3

4

5

PWR

COM

FLT

PWR

COM

FLT
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Connections and Interfaces

Figure 2.3 Connections and interfaces

Caution!
Loss of intrinsic safety
If Ex i protected circuits have been operated with non-intrinsically safe circuits, they must no 
longer be used as Ex i protected circuits.
To maintain the Ex i rating of the WirelessHART temperature converter, use an Ex i rated HART 
modem to communicate with the WirelessHART temperature converter.

1 Wired HART connectors for Ex ia certified HART modem
2 Sensor terminals
3 Cable glands (cable diameter 5.5 ... 10 mm)
4 Battery holder
5 Battery
6 Internal antenna (aligned vertically when device is mounted upright)
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3 Installation
3.1 Mounting Considerations
3.1.1 Positioning the Device

We recommend that you install the WirelessHART Gateway before installing other 
WirelessHART devices. This way, you can check for proper operation of new devices as they 
are installed. Please refer to the manual of the WirelessHART Gateway for further information.
Guidelines for Planning a WirelessHART Network

■ A line-of-sight between communication partners always is desirable. If a line-of-sight is 
not possible, the obstacles should not be massive and the partners should be more to the 
edge of an obstacle to allow the wave to "bend" around it (diffraction effect).

■ Consider moving objects that could affect the device's antenna range.
■ Install wireless devices at least 1 m above the ground or the floor.
■ Make sure that the device's antenna is aligned vertically for best results.
■ Make sure that a minimum of 2 other WirelessHART devices are well within the antenna 

range of the device.
■ Do not position WirelessHART devices directly below or above each other. They would be 

outside each other's antenna range.
■ Install WirelessHART devices at least 1 m away from each other.
■ Antennas must be at least 6 cm away from any wall or any metallic material running 

parallel to it.
■ Position the device as far away as possible from metal surfaces or walls containing metal. 

There should be as little metal close to the device as possible.
■ Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near 

WirelessHART devices. Keep in mind other wireless networks using the same frequency 
spectrum (WLAN, Bluetooth, etc.). Wireless technologies used in an industrial 
environment must be able to coexist without disrupting each other. If multiple networks 
operate in one facility, a frequency management should be applied as part of 
administration. 
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3.1.2 Antenna Characteristics
Before mounting the device, you should consider the devices's antenna characteristics and the 
propagation of the radio waves. The following diagrams show the antenna gain in two different 
planes.

Figure 3.1 Antenna gain (side view, 2450 MHz, dBi)

Figure 3.2 Antenna gain (top view, 2450 MHz, dBi)
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3.1.3 Examples for Good and Poor Positioning

Figure 3.3 Wave propagation, schematic representation (alpha = approx. 45°, may vary 
considerably)

Figure 3.4 Good positioning: Devices are within each others antenna range

1 Weaker signal above and below
2 Stronger signal sideways

PWR

COM

FLT

1

2 2

1

x

y
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Figure 3.5 Poor positioning: Devices are not within each others antenna range
x

y
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3.2 Mounting the Device

The mounting location should be well accessible for mounting and electrical installation. Make 
sure that there is enough space to open the housing cover and to access the terminals, 
switches, and cable glands. Choose a mounting location that meets the requirements of the 
climatic limits specified in the technical data.
The housing has a degree of protection of IP65 and is designed for wall mounting (mounting 
accessories not included).
Required tools

■ 2 screws (thread diameter M5)
■ Drill
■ Screwdriver

Mounting the Device
1. Drill 2 holes in the mounting surface so that they match the mounting holes of the housin.   

see Figure 4.1 on page 21
2. Screw the device to the mounting surface.

Danger!
Mechanical danger hazard
The device must be installed at locations providing low risk of mechanical danger according to 
IEC/EN 60079-0. Special care must be taken if the mounting location is at the end of the 
climatic limits specified in the data sheet.

Danger!
Explosion hazard
If the cable glands are not fitted correctly, the IP degree of protection cannot be ensured and 
the electronic components can be exposed to an explosive atmosphere.
Check cable glands:

■ all screws of the housing / housing cover must be tightened with the appropriate torque
■ only cables of the appropriate size must be used in the cable glands
■ all cable glands must be tightened with the appropriate torque
■ all seals must be undamaged and fitted correctly
■ all empty cable glands must be sealed with appropriate plugs

Note!
There are two ways to set up the device: You may either mount the device in the field first and 
configure it afterwards as described in this manual. Or, alternatively, you may configure the 
device first and mount it afterwards.
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3.3 Connecting the Sensors
The terminal block of the sensor interface is located inside the housing. The sensor interface 
has 2 channels. You may connect resistance thermometers (RTDs), slide-wire sensors (), 
thermocouples (TCs) or mV transmitters. Supported RTDs/TCs are:

■ TC types: E/J/K/T
■ RTD type: Pt100/Pt1000

Connecting the Sensors
1. Unscrew the four screws of the housing cover.
2. Remove the housing cover.
3. Route the cables through the cable glands of the housing.   see Figure 2.3 on page 12

The permissible cable diameter lies between 5.5 ... 10 mm.
4. Connect the temperature sensors to the corresponding terminals of the sensor interface 

according to the following figure.   see Figure 3.6 on page 18
5. Screw the housing cover to the housing.

 The sensors are connected.

Figure 3.6 Connecting the sensors

Caution!
Damage through wrong grounding
Grounded sensors must have equipotential ground, otherwise damage may be inflicted on the 
device, and sensor accuracy cannot be guaranteed.

Note!
Cold junction compensation for TC sensors
The Wireless Temperature Converter has a built-in cold junction compensation (CJC) which is 
sufficient in most cases. If an increased accuracy is required (for example because of unilateral 
temperature effects such as sunlight), it is recommended to use an external CJC. An external 
CJC can be obtained as an accessory from P+F (W-ACC-CJC). When using an external CJC, 
connect the TC sensor to input 1 and the external CJC to input 2.
Enable the internal/external CJC using the device DTM. see chapter 5.6.1

1 2
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1
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3
+

4
-

8
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Measuring ranges

The following table shows the measuring accuracy for an extended measuring range with 
temperatures below -200 °C.
Extended measuring range accuracy

1 Input 1
2 Input 2
3 Sensor interface
4 Two TCs
5 Two RTDs in 2-wire configuration
6 One TC and one RTD in 2-wire configuration (the two channels are interchangeable)
7 One RTD in 3-wire configuration
8 One RTD in 4-wire configuration

Sensor type Measuring Range Typical Accuracy
E -200 ... +1000 °C ±0,5 °C
J -210 ... +1200 °C ±1 °C
K -200 ... +1300 °C ±1 °C
T -200 ... +400 °C ±1 °C
Pt100/Pt1000 -200 ... +850 °C ±0,5 °C
100 mV -100 ... +100 mV 20 µV
300 mV 0 ... +300 mV 40 µV
500  0 ... +500  0.1 
4000  0 ... +4000  1 

Sensor type Extended Measuring Range Typical Accuracy
E -270 ... -200 °C ±2 °C
K -240 ... -200 °C ±2 °C
T -270 ... -200 °C ±2 °C
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4 Commissioning
4.1 Connecting the Battery

Danger!
Batteries in hazardous areas
Batteries from Pepperl+Fuchs for this device may be brought into hazardous areas. However, 
always check if the battery is intact before transporting it into hazardous areas. Always 
transport batteries enclosed inside their original packages or already installed inside the 
device.

Danger!
Loss of intrinsic safety
The use of batteries other than specified voids the qualification for use in hazardous areas.
Only use batteries of type W-BAT-B1-Li from Pepperl+Fuchs.

Danger!
Possible damage because of wrong battery
The use of batteries other than specified may cause damage to the device.
Only use batteries of type W-BAT-B1-Li from Pepperl+Fuchs.

Warning!
Caustic battery acid
Leaking battery acid can cause personal injury and damage to the device.

■ Never use batteries that are leaking.
■ Never use batteries with external damage such dents or deep scratches, even if no 

battery acid is leaking.

Danger!
Electrostatic discharge hazard
The device contains non-conductive plastic parts. Care must be taken when operating the 
installed device because of possible electrostatic charges. Electrostatic charged surfaces may 
cause an ignition spark.
Electrostatic charges must be avoided. For example, do not rub the device and never clean 
plastic surfaces with a dry cloth. Always use a damp cloth instead.

Note!
You may open the housing and connect/disconnect the battery in Zone 1.
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Figure 4.1 Mounting holes and housing screws

Connecting the Battery
1. Unscrew the four screws of the housing cover.
2. Remove the housing cover.
3. Insert the battery into the battery holder observing the polarity.
4. Screw the housing cover to the housing.

4.2 Switching on the Device
Switching on the Device
1. Switch on the device by pressing button A for 5 seconds. See chapter 6.1

 All LEDs light up.
2. Release the button.

 The LEDs go off again. After a short time the green "PWR" LED lights up on for a few 
seconds if the battery is recognized as a non-exhausted battery. The device is now 
switched on. To save battery power, all LEDs are off. 
The device attempts to join the network autonomously using the fast join mode. In the fast 
join mode, the radio is activated more frequently than in the standard join mode. If the 
device is not able to join the network within 30 minutes, it will end the fast join mode and go 
into standby mode.

1 Mounting holes
2 Housing cover screws

PWR

COM

FLT 11

22
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4.3 Initial Configuration via HART Modem
For security reasons, the network ID and join key have to be configured through a wired 
connection before the device can connect itself to a WirelessHART network. To do so, you can 
use an Ex ia certified HART modem that connects to a PC/Laptop using the USB interface or 
the RS232 interface.

Connecting the device to a PC/Laptop via HART modem
Install the HART modem drivers on your PC/Laptop according to the instructions given by the 
manufacturer.
1. Unscrew the four screws of the housing cover.
2. Remove the housing cover.
3. Connect the Ex ia certified HART modem to the wired HART connectors.   see Figure 2.3 

on page 12
4. Switch on your PC/Laptop.
5. Plug the HART modem into the USB/RS232 port.

 In case you are using the USB port, your PC/Laptop should recognize the HART modem 
automatically.
If using the RS232 port, proceed with the next step.

6. To find out to which COM port the HART modem is connected, open the Windows® device 
manager. For example, if using Windows® XP, click Start > Settings > Control Panel > 
System > Hardware > Device Manager, or if using Windows® 7, click Windows Icon > 
Control Panel > System > Device Manager.

 Under Ports (COM & LPT) you see the HART modem and the COM port assigned to it. 
You will need the COM port number later on.

Caution!
Loss of intrinsic safety
If Ex i protected circuits have been operated with non-intrinsically safe circuits, they must no 
longer be used as Ex i protected circuits.
To maintain the Ex i rating of the WirelessHART temperature converter, use an Ex i rated HART 
modem to communicate with the WirelessHART temperature converter.
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4.4 DTM Software
4.4.1 Downloading the Required Software

Required software:
■ Microsoft® .NET Framework
■ PACTwareTM Framework
■ WirelessHART DTM

The DTM collection including WirelessHART device DTMs and Ethernet communication 
DTM.

■ HART CommDTM
The HART CommDTM has to be installed separately. It is required for wired 
communication via HART modem. The HART CommDTM supports both FSK (i.e. HART 
modem) and RS-485 interfaces.

Where to download the required software?
1. Open your internet browser and visit www.pepperl-fuchs.com.
2. Click Products.
3. Click Software.
4. Download the software components Microsoft® .NET Framework, PACTwareTM, 

WirelessHART DTM and HART CommDTM. You might need to scroll down the page to 
find the required component.

5. Unzip the downloaded files and store the data to your local hard drive.
4.4.2 Install the DTM Software Components

Your computer must meet the following requirements in order to run PACTwareTM and the 
device DTM:

■ Operating system: Windows® 2000 Service Pack 4, Windows® XP Service Pack 1/2/3 or 
Windows® Vista

■ Software: Microsoft® .NET Framework Release 1.1 Service Pack 1
■ Processor: 500 MHz or faster
■ Memory: 256 MB RAM or more
■ Disk space: 200 MB or more
■ Graphics resolution: 1024 x 768 or higher
■ Administrator privileges to enable software installation

Note!
If one of the software components is already installed on your system, the installation may be 
omitted.
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Install the DTM Software Components
1. Install the Microsoft® .NET Framework by starting the corresponding setup.exe file and fol-

lowing the installation instructions given on the screen.
2. Install PACTwareTM by starting the corresponding setup.exe file and following the installation 

instructions given on the screen.
3. Install the WirelessHART DTM collection by starting the corresponding setup.exe file and 

following the installation instructions given on the screen.
4. Install the HART CommDTM by starting the corresponding setup.exe file and following the 

installation instructions given on the screen.
 You have installed the required software.

4.4.3 Updating the DTM Catalog
Once you have installed the FDT base application and the Device Type Manager (DTM) on the 
computer, the FDT base application's DTM catalog must be updated. The PACTwareTM DTM 
catalog is called "Device Catalog" and is normally automatically updated when PACTwareTM is 
launched.
If PACTwareTM does not update the device catalog automatically, proceed as follows.
Updating the Device Catalog
1. Start PACTwareTM.
2. Select View > Device Catalog or press F3 or click on the Device Catalog icon in the icon 

bar.
 The Device Catalog window opens.

3. Click on the Update Device Catalog button to update the device catalog.

Figure 4.2 PACTwareTM device catalog

4. Click on Yes to continue.
 The updated device catalog appears once the search has finished.

Figure 4.3 PACTwareTM search for DTM
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4.5 Creating a new Project in PACTwareTM

4.5.1 Creating a New Project
Creating a new project in PACTwareTM?
Select File > New or click on the Create New Project icon on the toolbar.

 A new, unnamed project appears in the main window. The project initially consists of the 
entry HOST PC.

4.5.2 Adding the Communication DTM
A communication DTM is an interface between the FDT frame application and the device DTM. 
The communication DTM enables communication between the device DTM and the device 
connected to the PC.
For the PC to communicate with the device via the HART modem, a HART communication 
DTM has to be added to the PACTware project.
Adding HART Communication DTM

1. Select the entry HOST PC in the project view of your PACTwareTM project.
2. Choose Device > Add device or click the Add device icon on the toolbar.

 The Device for window appears.

Figure 4.4 Device for window

3. Select the entry HART communication.
4. Click OK.

 The HART communication DTM is added to the project.

Note!
The HART CommDTM is not included in the WirelessHART DTM Collection. It can be 
downloaded separately from www.pepperl-fuchs.com. see chapter 4.4
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Figure 4.5 HART communication DTM in the PACTwareTM project view

5. To edit the parameters, double-click on the HART communication DTM.
 The parameter window appears.

Figure 4.6 Parameter window of HART communication DTM

6. Set the parameters according to the following table.
7. Click OK to save the changes and to close the parameter window.
Parameter Description Default
Communication 
interface

Set this parameter to HART modem. HART 
modem

Port Set this parameter to the COM port your HART modem is 
connected to (see chapter 4.3).

COM1

Master Set this parameter to Primary master. Primary 
Master

Preamble Number of preambles for HART communication. 
Select at least 10 preambles for communication with the 
WHA-UT. Otherwise the WHA-UT will not respond.

5

Number of 
communication 
retries

The number of retries for HART communication in case of an 
error.

3

Start address Here the address range is set, in which the HART 
Communication DTM is to search for HART devices 
connected to the HART modem.
The default polling address of the WHA-UT is "1".

0
End address 15

Multimaster and 
Burst mode 
support

Leave this checkbox deactivated. deactivat
ed
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4.5.3 Adding Device DTM
Performing a HART Scan
1. In the project view, right-click on the entry of the communication DTM.
2. Choose Connect.
3. Choose Additional functions > Scan list.
4. If the scan does not begin automatically, click Refresh.

 The detected field devices are displayed in the Scan list window.
Adding the Device DTM
You may add the temperature converter to your PACTwareTM project in various ways (see 
PACTwareTM documentation). One of them is described in the following.
1. In the project view, right-click on the entry of the HART communication DTM.
2. To add the device DTM, choose Add device.

 The Device for window opens.

Figure 4.7 Device for window

3. Select the entry WHA-UT.
4. Click OK.

 The device DTM is added to the project. You may continue with parameterizing the 
temperature converter as described in the following.

Figure 4.8 DTM of the WirelessHART Temperature Converter in the PACTwareTM project view

5. Remember to save your PACTwareTM project from time to time (File > Save).
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4.6 Joining the Wireless Network
To connect itself to the WirelessHART network, the device must carry the correct Network ID 
and Join Key. The Network ID and Join Key have to be configured using a wired connection 
before the device joins the WirelessHART network for the first time.
To enter Network ID and Join Key, the following requirements have to be met.

■ A PC/Laptop is connected to the device using a HART modem.
■ A PACTwareTM project containing the HART communication DTM and the device DTM 

has been created.
In the joining phase the device sends a join request packet to the network manager. If the new 
device can be authenticated, the network manager responds with an activation packet and sets 
up links between the new device and other existing nodes. Furthermore, the new device 
receives a 128 Bit encryption key.
Entering Network ID and Join Key
1. In the PACTwareTM project, right-click the DTM of the device that shall join the Wire-

lessHART network.

Figure 4.9 DTM of the WirelessHART Temperature Converter in the PACTwareTM project view

2. Choose Connect.
 A connection is established.

3. To open the online parameterization window, right-click the device DTM and choose 
Parameter > Online parameterization.

 The online parameterization window appears.
4. In the online parameterization window, choose Wireless Communication.

 The wireless communication parameters are displayed. See chapter 5
5. Enter the Network ID into the Network Identification field and press Enter to confirm the 

new value.
6. Enter the Join Key into the 4 Join Key fields and press Enter to confirm the new value.
7. Click Execute Join.

 The device attempts to join the wireless network. The connection status is indicated by 
Join Status.

Activating Fast Join Mode
After the device has been switched on, it attempts to join the network autonomously using the 
fast join mode. In fast join mode, the radio is activated more frequently than in the standard join 
mode and thus consumes more power. If the device is not able to join the network within 30 
minutes, it will go into standby mode.
You may speed up the joining phase anytime by activating the fast join mode manually.
1. Activate the fast join mode by pressing button A for 5 seconds. See chapter 2.4

 After 5 seconds the yellow LED starts flashing at 3 Hz.
2. Release button A immediately.

 The yellow LED extinguishes. The device initiates the fast join mode. As soon as the 
device has joined the network it enters the "Joined" status or the "Connected" status.
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5 Configuration
5.1 Configuration Options

We recommend that you configure the device on the shop floor via a wired connection using 
a HART modem. see chapter 4.3

1. Define all basic settings such as wireless communication parameters (Network ID, Join 
Key, Join Mode) and identification parameters (Long Tag, Polling Address) using a HART 
modem.

2. Make the device join the WirelessHART network.
3. Once the device has joined the WirelessHART network, configure the burst mode param-

eters, event notifications, and other application settings using a HART modem.
4. Disconnect the HART modem and install the device in the field.

Once the device is installed in the field, you can change the configuration of the device via a 
wireless connection using the WirelessHART Gateway.
Wireless Configuration via the WirelessHART Gateway
We assume that the WirelessHART Gateway is installed and configured correctly according to 
the manual of the WirelessHART Gateway. Furthermore, we assume that the device to be 
configured has joined the WirelessHART network.
1. Start your PACTwareTM project containing the device DTM of the WirelessHART Gateway.

Figure 5.1 DTM of the WirelessHART Gateway in the PACTwareTM project view

2. In the project view, right-click on the entry WHA-GW.
3. To add the device DTM, choose Add device from the context menu.

 The Device for window opens.
4. Select the entry of the WirelessHART device you want to add to the PACTwareTM project.
5. Click OK.

 The device DTM is added to the project.
Now you can continue with parameterizing the device as if you had a wired connection. see 
chapter 5.2

Figure 5.2 DTM of the WirelessHART Temperature Converter in the PACTwareTM project view

Note!
Note that you can accelerate the wireless configuration by establishing a fast pipe connection 
between the device and the WirelessHART Gateway. For more information on fast pipe 
connections, see the manual of the WirelessHART Gateway.
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5.2 Online and Offline Parameterization (DTM)

The device DTM provides dialogs for offline and online parameterization.
■ Offline Parameterization (not connected to device)

If there is no active connection to the device, only the data that is stored locally in the 
PACTwareTM project can be edited and saved. You can store this local copy of the data to 
the device, as soon as a connection to the device has been established.
Before editing the data offline, you can load the latest version of the data from the device, 
to ensure that you edit the latest data.

■ Online Parameterization (connected to device)
If there is an active connection to the device. You can directly edit the data that is stored 
on the device. Parameter changes are immediately stored on the device.

Both online and offline data are updated using the commands Store to device and Load from 
device.

Parameterizing Offline
1. Right-click the device entry in the PACTwareTM project.

 A context menu opens.
2. Choose Parameter > Offline Parameterization.

 The window containing the offline data record appears.
3. Modify a parameter by typing in a new value or choosing a new value from the drop-down 

list.
4. To accept the new value, press Enter.
5. After all parameter changes have been made, save your project by choosing File > Save.
6. To write the new offline configuration to the device, right-click the device entry in the project 

view and choose Connect.
 A connection to the device is established.

7. Right-click the device entry again and choose Store to device.
 The new configuration is stored in the device.

Note!
The concept of online/offline parameterization applies to the configuration via DTM and 
PACTwareTM only.

Note!
Data edited and stored on the device during online parameterization is not automatically 
synchronized with the offline data record in the PACTwareTM project. If you change device 
parameters in the online mode, the data stored in the PACTwareTM project differs from the data 
stored on the device.
To ensure that the data stored in the PACTwareTM project matches the data stored on the 
device, after online parameterization, load the data from the device into the PACTwareTM 
project.
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Parameterizing Online
1. Right-click the device entry in the PACTwareTM project.

 A context menu opens.
2. Select Connect.

 A connection to the device is established.
3. Right-click the device entry in the PACTwareTM project.
4. Select Parameter > Online Parameterization.

 The window containing the online data opens and the data is read from the device.
5. Modify a parameter by typing in a new value or choosing a new value from the drop-down 

list.
6. To accept the new value, press Enter.

 The new value is stored in the device immediately.
7. After all parameter changes have been made, you may store the online configuration into 

the PACTwareTM project. To do this, right-click on the device entry in the project view and 
choose Load from device.

 The device date is stored in the PACTwareTM project.
8. Save your project by choosing File > Save.

5.3 Identification Parameters
The identification parameters provide various information about the device and identify the 
device within the network.

Figure 5.3 Identification parameters

Note!
Many device parameters can be edited both online and offline. The parameters that can only 
be edited online are especially pointed out in the following sections.
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Identification Parameters

5.4 Wireless Communication Parameters
The wireless communication parameters apply to the WirelessHART network which the device 
will join.

Figure 5.4 Wireless communication parameters

Parameter Description Default
Device TAG Identifies the device in a WirelessHART network (long tag). 

Enter up to 32 characters.
–

Short device TAG Identifies the field device within the process plant. Enter up to 
8 characters.

–

Descriptor Further description of the device. Enter up to 16 characters. –

Date User-defined date (e.g. last parameter change). Format: 
DD.MM.YYYY
The Date parameter is not modified by the Gateway itself. 
Instead it has to be set by the user or Host application.

–

Message User defined message. Enter up to 32 characters. –

Table 5.1 Identification Parameters
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Wireless Communication Parameters

Note!
The data listed in the following table is available only during online parameterization.

Parameter Description Default
Network 
Identification

Unique network ID of the WirelessHART network the device is 
supposed to join. Enter up to 5 digits (0 ... 65535).

1945

Wireless 
Operation Mode

Indicates current mode of operation of the device:
■ Idle: initializing or not in Join Mode
■ Active Search: searching for neighboring WirelessHART 

devices at high duty cycle (100%)
■ Negotiating: join requested
■ Quarantined: authenticated by the Network Manager
■ Operational: device is connected to the network and is 

using the assigned links
■ Suspended: device has been disconnected by the network 

manager
■ Deep Sleep/Ultra-low Power/Passive Search: device is 

inactive or searching with low duty cycle (< 100%)

–

Radio Power Power of the radio signal emitted by the device. The Radio 
Power parameter value may be changed only if the device is 
not yet connected to the network.

10 dBm

Join Key Part x of 
4

The join key is the password for the network the device is to 
join. Enter up to 32 hexadecimal characters (0 ... 9, A ... F). 
There are four text fields which can hold up to eight characters 
each.

–

Join Shed Time Time (hh:mm:ss) that the device is given to join the network 
after the Join Mode condition has been fulfilled. After this time 
has elapsed, the device will keep on trying to join the network 
using a low duty-cycle receive mode to reduce energy 
consumption. This paramter is fixed and set to the default 
value.

00:30:00

Join Mode Method by which the device is to join the network.
■ Do not attempt to join
■ Join now
■ Attempt to join immediately on powerup or reset

Attempt 
to join 
immediat
ely ...

Execute Join Press the button to store the Join Shed Time and Join Mode 
parameters to the device. The device will attempt to join the 
network in the way that is specified in Join Mode.

–
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Join Status Indicates the current status when joining the network. Possible 
messages:
■ Network Packets Heard
■ ASN Acquired
■ Synchronized to time slot
■ Advertisement Heard
■ Join Requested
■ Join Retrying
■ Join Failed
■ Authenticated
■ Network Joined
■ Negotiating Network Properties
■ Normal Operation Commencing

–

Total number of 
Neighbors

Number of WirelessHART devices within the antenna range of 
the device to which a connection has been made.

–

Number of 
Advertising 
Packets received

Number of advertising packages received by the device. –

Number of Join 
Attempts

Number of attempts the device has made to join the network. –

Active 
Advertising Shed 
Time

Time in hh:mm:ss that the device is given to advertise its 
presence to its neighbors in order that they can join the 
network quickly.

00:40:00

Request Active 
Advertising

Pressing this button will cause the device to advertise its 
presence for the period Active Advertising Shed Time.

–

Number of 
Neighbors 
Advertising

Number of neighbors that are advertising their presence and 
have been detected by the device.

–

Table 5.2 Wireless Communication Parameters

Parameter Description Default
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5.5 Wired Communication Parameters

Figure 5.5 Wired communication parameters

Wired Communication Parameters

5.6 Application Settings
The Application Settings menu and its sub-menus contain the parameters and information 
relevant for the temperature converter's application.

Figure 5.6 Application Settings

Application Settings

Parameter Description Default
Polling Address HART address of the temperature converter on the wired 

interface, valid range 0 ... 63.
1

Table 5.3 Wired Communication Parameters

Parameter Description Default
Update Rate Update rate of the sensor values. Select a value from the drop-

down list.
60 s

Table 5.4 Application Settings
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5.6.1 Sensor Parameters
The 2 sensor inputs of the temperature converter are configured separately with the sub-menus 
Input 1 and Input 2. Because both sub-menus are identical apart from the parameter 
Connection, only Input 1 is described in the following.

Figure 5.7 Application Settings > Sensor > Input 1 (Selected Sensor Type: RTD)

Figure 5.8 Application Settings > Sensor > Input 1 (Selected Sensor Type: TC)
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Sensor Parameters Input 1/Input 2

Note!
If you select an RTD in 3-wire connection or in 4-wire connection in the Input 1 menu, the 
Input 2 menu will not be available anymore. An RTD in 3-wire connection or in 4-wire 
connection uses both inputs and is configured via Input 1.

Parameter Description Default
Sensor Type Selects the type of sensor connected to the respective input. Pt100
Connection Determines how the resistance thermometer (RTD) selected 

under Sensor Type is connected.
The Connection parameter is available in the Input 1 menu 
only. The parameter is grayed out if Sensor Type is a TC or an 
mV transmitter.
If "3-wire" or "4-wire" is selected, the Input 2 menu is not 
available.

2-wire

Lower value The temperature that corresponds to 4 mA. This parameter is 
not available for Input 2.

0 °C

Upper value The temperature that corresponds to 20 mA. This parameter is 
not available for Input 2.

100 °C

Lead Breakage Enables or disables the lead breakage detection. Lead 
Breakage is visible only if a TC or mV transmitter is selected 
under Sensor Type.

Enable

Cold Junction 
Compensation

Enables or disables the cold junction compensation. The 
Cold Junction Compensation (CJC) parameter is not visible 
if Sensor Type is a RTD or a slide-wire sensor.
Input 1: You may choose between the following values.
■ Internal: Uses the internal CJC (built-in).
■ External: Uses an external CJC. The external CJC is an 

accessory which can be obtained from Pepperl+Fuchs (W-
ACC-CJC). The external CJC has to be connected to Input 
2.

■ Disable: No CJC.

Input 2: You may choose between the following values.
■ Internal: Uses the internal CJC (built-in).
■ Disable: No CJC.

-

Lead Resistance 
Compensation

Enables or disables lead resistance compensation. When an 
RTD is connected in 2-wire connection, the resistance of the 
measurement lead is in series with the sensor. It is therefore 
added to the sensor resistance and is included in the 
measurement result. Lead Resistance Compensation 
compensates for this error.
The Lead Resistance Compensation parameter is not 
visible if Sensor Type is a TC or an mV transmitter.

Enabled

Lead Resistance 
Compensation 
Value

Specifies the lead resistance value to compensate for 
measurement errors (only with RTD 2-wire connection).

0 

Table 5.5 Sensor Parameters Input 1/Input 2
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5.6.2 Burst Mode Parameters
Burst mode is a special communication mode in which a HART slave device sends responses 
to a particular HART command on a predetermined, periodic schedule without being polled by 
the master. Normally, a HART slave device only responds when being polled by the master. 
When burst mode is used, a HART slave device can publish data (for example process values) 
independently in regular time intervals. Data can be sent as scheduled, or only if the value has 
changed by a significant amount or has not been updated within a default reporting time.
Up to 3 different burst modes can be set in the Burst Mode menu.

Figure 5.9 Application Settings > Burst Mode > Burst Mode 1

Burst Mode 1/2/3 Parameters

Note!
Battery lifetime
The more frequently burst messages are sent the more battery power is consumed, thus 
reducing battery lifetime.

Parameter Description Default
Burst Mode 
Control Code

Switches burst mode on or off ("Wireless" = on).
The following parameters in this table can only be edited if 
Burst Mode Control Code is set to "Wireless". Otherwise 
they are grayed out.

Off

Period [s] Determines the period in hh:mm:ss that elapses between 
burst messages.

00:00:32

Max. Period [s] Should be set like the Period [s] parameter. This parameter is 
currently not used.

00:00:32
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Burst Command 
Number

Determines which commands are to be sent in the burst 
message.
■ Primary variable: Returns the primary value and units.
■ Loop current and percentage of range: Returns the loop 

current and its associated percent of range.
■ Dynamic variables and loop current: Returns the loop 

current and up to four predefined dynamic variables and 
units (PV, SV, TV, QV).

■ Device variables: Returns the value of up to 4 device 
variables.

■ Additional device status: Returns the device status 
information.

■ Device variables and additional device status: Returns the 
value of up to four device variables and the device status 
information.

Primary 
variable

Device Variable 
Code 1 ... 4

Determines which device variables are to be sent in the burst 
message (up to 4). Each of the 4 drop-down lists has the same 
contents:
■ Channel 1: Value measured from input 1
■ Channel 2: Value measured from input 2
■ Internal cold junction temperature: Sends the temperature 

of the internal cold junction for compensation
■ Battery voltage
■ Percentage of battery capacity
■ Estimated lifetime: Sends remaining battery lifetime
■ Percent range: Percent of range of the loop current
■ Loop current. Sends the value of the loop current
■ Not used: If not all 4 device variables are to be used, 

deacticate the desired device variable by selecting "Not 
used".

The Device Variable Code 1 ... 4 parameters are grayed out 
depending on the value of the parameter Burst Command 
Number.

Not used

Table 5.6 Burst Mode 1/2/3 Parameters

Parameter Description Default
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6 Operation
6.1 Controls and Indicators

The buttons and LED indicators can be accessed without opening the housing.

Figure 6.1 Controls and indicators

1 Button A
2 Button B
3 Red FLT LED
4 Yellow COM LED
5 Green PWR LED

1

2

3

4

5

PWR

COM

FLT

PWR

COM

FLT
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6.1.1 LEDs

When button A is pressed shortly (0.2 s ... 5 s), the three LEDs indicate the status of the device. 
See chapter 6.1.2

Note!
To save battery power all LEDs are off during normal operation, even if the device is 
communicating or joining the network. The LEDs only light up after start up or while pressing 
the buttons.

LED indications
Number of LEDs 3 (green, yellow, red)

Indications of green "PWR" LED (battery status)
LED on Status "Normal": At least three months of battery life are left
LED flashes at 1 Hz Status "Warning": At least one month of battery life is left
LED flashes at 3 Hz Status "Alarm": Less than one month of battery life is left, or the battery 

is critically low.
LED off Status "Off": The battery is flat or disconnected.

Indications of yellow "COM" LED (communication status)
LED on Status "Connected": The device was has full network connection. It is 

able to communicate with at least 2 wireless nodes. At least one 
alternative communication path to the gateway is available.

LED flashes at 1 Hz Status "Joined": The device was able to join the network. However, it 
can communicate with a single wireless node only. There is no 
alternative communication path to the gateway.

LED flashes at 3 Hz Status "Joining": The device is attempting to join the network. If joining 
at high-duty cycle has failed, the device keeps on trying to join the 
network using a low duty-cycle receive mode to reduce energy 
consumption. 
The device will try to join the network until the battery is fully 
discharged. It is advised to switch the device off when not in use.

LED off "Standby" mode: Joining the network cannot be accomplished or join 
mode is set to "Do not attempt to join". See chapter 5.4

Indications of red "FLT" LED (error)
LED on Internal fault: An internal fault condition has been identified (e.g. A/D 

converter, microprocessor, CJC, radio); device fault that cannot be 
remedied by the user.

LED flashes at 1 Hz External fault: An external abnormal condition (e.g. sensor burnout) 
has been identified; the fault can possibly be remedied by the user.

LED flashes at 3 Hz Information: Device is disconnecting from the network before 
switching itself off.

LED off There is no error.
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6.1.2 Buttons
Depending upon the length of time they are pressed, the buttons A and B call various functions.
Functions of Button A
Time 
pressed Function Procedure

Functions of button A (device switched off)
> 5 s Switching on the device If the device is switched off, switch on the device as 

described below.
■ Keep button A pressed for 5 s. After 5 seconds all 

3 LEDs light up for 1 second.
■ Release button A.

After a short while the green LED lights up for a 
few seconds if the battery is recognized as a non-
exhausted battery. Then, all LEDs are off again.
The device attempts to join the network 
autonomously using the fast join mode. In the fast 
join mode, the radio is activated more frequently 
than in the standard join mode. If the device is not 
able to join the network within 30 minutes, it will 
end the fast join mode and go into standby mode.

Functions of button A (device already switched on)
0.2 ... 5 s Status test ■ Press button A for more than 0.2 s and less than 

5 s.
■ Release button A.

The LEDs display the current device status. see 
chapter 6.1.1

5 ... 10 s Activating fast join mode The device starts the fast join mode autonomously 
for 30 minutes after it is has been switched on. 
However, you may speed up the joining phase 
anytime by activating the fast join mode manually.
■ Keep button A pressed for 5 s.

After 5 s the yellow LED starts flashing at 3 Hz.
■ Release button A.

The yellow LED extinguishes.
The device starts joining.

> 10 s Switching off the device ■ Keep button A pressed for 10 s. 
After 5 s the yellow LED starts flashing at 3 Hz. 
After 10 s the red LED starts flashing at 3 Hz.

■ Release button A.
The red LED stops flashing after a few seconds.
The device saves the current configuration and 
switches itself off.
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Functions of Button B
Time 
pressed Function Procedure

Functions of button B
> 3 s 2-wire RTD 

compensation (line 
resistance)

If a channel has been configured as 2-wire RTD, the 
line resistance can be compensated with this 
function.
■ Jumper the sensor and keep button B pressed at 

the same time.
After 3 s the green LED starts flashing at 3 Hz.

■ If you want to compensate channel 1, release 
button B immediately.

■ If you want to compensate channel 2, keep button 
B pressed until also the yellow LED starts flashing 
at 3 Hz.

■ Release button B.
After releasing button B, the LED(s) start flashing 
at 1 Hz during the compensation process.
As soon as the compensation is finished, the 
LED(s) remain switched on for another 5 
seconds. After this, the line resistance is 
compensated.

If the red "FLT" LED lights up, a fault has occurred 
during the process (blinking at 1 Hz = no RTD 
connected or configured; blinking at 3 Hz = sensor 
burnout; LED permanently on = wire resistance 
bigger than 10 ).

> 18 s Reset of consumed 
battery charge

The device measures the consumed battery charge. 
When an old battery is replaced with a new one, this 
function has to be reset to achieve a correct 
measurement. After having inserted the new battery, 
press button B for 18 seconds. As soon as all LEDs 
light up, release the button. The function has been 
reset.
■ After having inserted the new battery, keep button 

B pressed for 18 seconds.
After 3 s the green LED starts flashing at 3 Hz.
After 8s the yellow LED starts flashing at 3 Hz.
All LEDs go off again.
After 18s all LEDs light up.

■ Release button B. The function has been reset.
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6.2 Measured Value
The Measured Value function displays the currently measured values of the sensors 
connected to the sensor inputs (PV, SV, TV, QV).
Accessing the Measured Value windows
1. In the PACTware project, right-click on the device.

 A context menu opens.
2. Select Measured Value.

 The Measured Value window appears.

Figure 6.2 Measured value

6.3 Diagnostics
The Diagnostics function provides detailed information about the device, wireless/wired 
communication and health status.

Accessing the Diagnostics Window
1. Right-click the device in the PACTwareTM project tree.
2. Select Diagnostics.

Note!
Available Only Online (DTM)
If using the configuration via DTM and PACTwareTM the Diagnostics function is available only 
online. see chapter 5.2
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6.3.1 Identification
Identification provides information about the hardware and software of the device.

Figure 6.3 Diagnosis > Identification

Diagnosis - Identification

Note!
The data listed in the following table is available only during online parameterization.

Parameter Description
Device Tag Identifies the device in a WirelessHART network.
Short device Tag Identifies the field device within the process plant
Descriptor Further description of the device.
Date User-defined date (e.g. last parameter change).

Date is not modified by the Gateway itself. Instead is has to be set by 
the user or Host application.

Message User defined message.
Real time clock date Shows the date currently set in the device.
Real time clock time Shows the time currently set in the device.
Device Revision Software revision of the device.
Software Revision Software revision of the device.
Hardware Revision Hardware revision of the device.
Universal Command 
Revision

Revision of the HART protocol supported by the WHA-UT.

Table 6.1 Diagnosis - Identification
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6.3.2 Wireless Communication
Wireless Communication provides information about the operation of the device within the 
WirelessHART network.

Figure 6.4 Diagnosis > Wireless Communication

Diagnosis - Wireless Communication

Note!
The data listed in the following table is available only during online parameterization.

Parameter Description
Network 
Identification

Network ID of the wireless network.

Nickname Short destination address of the device.
Number of available 
Neighbors

Number of WirelessHART devices within the antenna range of the 
device to which a connection has been made.

Table 6.2 Diagnosis - Wireless Communication
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6.3.3 Health Status
The Health Status menu contains diagnostic information. The information is displayed in three 
different ways according to:

■ NAMUR NE107 guidelines,
■ ASM guidelines,
■ HART specification.

Open the corresponding sub-menu to view the respective information.
NAMUR

Figure 6.5 Diagnosis > Health Status > NAMUR

The following status messages according to the NAMUR NE107 guidelines can be displayed:
■ Good 
■ Failure (F) 
■ Maintenance required (M)
■ Out of specification (S)
■ Function check (C)
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ASM

Figure 6.6 Diagnosis > Health Status > ASM

The following status messages according to the ASM guidelines can be displayed:
■ Faults in the sensor or actuator 
■ Faults in the electronics
■ Installation or start-up faults
■ Out of specification.

HART

Figure 6.7 Diagnosis > Health Status > HART

The HART health status window provides various information, for example about wireless 
communication, device status and burst messages. The information is self-explanatory and 
therefore is not further explained in this manual.
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6.3.4 Power Supply
The Diagnosis > Power Supply > Battery menu contains information on the battery unit of 
the device.

Figure 6.8 Diagnosis > Power Supply > Battery

Diagnosis - Battery

6.4 Additional Functions
Accessing the Additional Functions Windows
1. Right-click the device in the PACTwareTM project tree.
2. Select Additional functions and choose the desired function.

6.4.1 Reset
Reset restarts the device. A device reset is like a power up with the difference that if the module 
was already connected to the network, it disconnects properly before powering down. No 
parameters will be reset.
Choose Additional Functions > Reset and press the button Device Reset to perform a reset.

6.4.2 Self Test
After pressing the Perform Self-Test button in the Additional Functions > Self Test menu the 
device carries out a self test.
The results of the self test can be seen in the Diagnostics menu. see chapter 6.3

6.4.3 About
Additional Functions > About displays information about the device, its manufacturer, and its 
firmware version.

Parameter Description
Estimated lifetime Number of days battery power will last under the current load 

conditions.
Temperature Current device temperatore.
Battery voltage Current battery voltage.
Percentage of 
battery capacity

Percentage of battery capacity left.

Table 6.3 Diagnosis - Battery
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7 Maintenance and Repair
7.1 Exchanging the Battery

Only batteries of type W-BAT-B1-Li can be changed in an area known to be hazardous. You can 
order these battery units from Pepperl+Fuchs under the part no. 219035.

Danger!
Batteries in hazardous areas
Batteries from Pepperl+Fuchs for this device may be brought into hazardous areas. However, 
always check if the battery is intact before transporting it into hazardous areas. Always 
transport batteries enclosed inside their original packages or already installed inside the 
device.

Danger!
Loss of intrinsic safety
The use of batteries other than specified voids the qualification for use in hazardous areas.
Only use batteries of type W-BAT-B1-Li from Pepperl+Fuchs.

Danger!
Possible damage because of wrong battery
The use of batteries other than specified may cause damage to the device.
Only use batteries of type W-BAT-B1-Li from Pepperl+Fuchs.

Warning!
Caustic battery acid
Leaking battery acid can cause personal injury and damage to the device.

■ Never use batteries that are leaking.
■ Never use batteries with external damage such dents or deep scratches, even if no 

battery acid is leaking.

Danger!
Electrostatic discharge hazard
The device contains non-conductive plastic parts. Care must be taken when operating the 
installed device because of possible electrostatic charges. Electrostatic charged surfaces may 
cause an ignition spark.
Electrostatic charges must be avoided. For example, do not rub the device and never clean 
plastic surfaces with a dry cloth. Always use a damp cloth instead.

Note!
You may open the housing and connect/disconnect the battery in Zone 1.

Note!
The device has a permanent memory. All device settings are stored if the device is switched off 
properly before changing the battery. If you change the battery without switching off the device 
first, the settings cannot be saved.
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Changing the Battery
1. Switch off the device by pressing button A for 10 seconds. See chapter 6.1

 After 5 seconds the yellow LED starts flashing at 3 Hz. After 10 seconds the red LED 
starts flashing at 3 Hz.

2. Release the button.
 The red LED stops flashing after a few seconds. The device saves the current 

configuration and switches itself off.
3. Unscrew the four screws of the housing cover.
4. Remove the housing cover.
5. Extract the fresh battery from its package. Do not throw the empty package away.
6. Remove the the exhausted battery from the device.
7. Place the exhausted battery inside the empty battery package.
8. Insert the new battery of the correct type into the battery holder observing the polarity.
9. Screw the housing cover to the housing.
10.Switch on the device by pressing button A for 5 seconds. See chapter 4.2

 After 5 seconds all 3 LEDs light up for 1 second.
11.Release the button.

 After a short while the green LED lights up for a few seconds if the battery is recognized 
as a non-exhausted battery.

12.Reset the measurement of the consumed battery charge by pressing button B for 18 
seconds until all LEDs light up for a short time. See chapter 6.1

13.Release button B.
 The function has been reset.

7.2 Disposal of Batteries
The battery / the battery unit is non-rechargeable. The batteries are non-hazardous when used 
according to the recommendations of the manufacturer. However, they do contain hazardous 
substances and therefore must be disposed of in compliance with the applicable laws and 
guidelines of the corresponding country.

Note!
■ When operating at ambient conditions different from the conditions specified, battery 

capacity can be reduced up to 50%.
■ The device has internal battery diagnostics that can send a warning when battery 

conditions are outside the acceptable operating range.
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8 Troubleshooting
8.1 Faults indicated by LEDs

For more information on the LED indications: see chapter 6.1.1.

Note!
To save battery power all LEDs are off during normal operation, even if the device is 
communicating or joining the network. The LEDs only light up after start up or while pressing 
the buttons.

Green LED (battery status)
State Possible cause(s) Action(s)
LED flashes at 1 Hz Status "Warning": At least one 

month of battery life is left.
Change battery within a month 
(see chapter 7.1).

LED flashes at 3 Hz Status "Alarm": Less than one 
month of battery life is left.

Change battery immediately 
(see chapter 7.1).

LED remains off after pressing 
button A for more than 
0.2 seconds and less than 
5 seconds. 

Status "Off": 
■ The battery is flat or 

disconnected.
■ The device has been 

switched off.

■ Change battery (see 
chapter 7.1).

■ Switch on the device (see 
chapter 4.2).

Yellow LED (communication status)
State Possible cause Action(s)
LED flashes at 1 Hz Status "Joined": The device 

was able to join the network. 
However, it can communicate 
with a single wireless node 
only. There is no alternative 
communication path to the 
gateway.

■ Add a WirelessHART 
device which is within the 
antenna range of the 
affected device.

■ Change the position of the 
affected device.
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LED flashes at 3 Hz Status "Joining": The device is 
attempting to join the network. 
If joining at high-duty cycle 
has failed, the device keeps 
on trying to join the network 
using a low duty-cycle receive 
mode to reduce energy 
consumption. The device will 
try to join the network until the 
battery is fully discharged. It is 
advised to switch the device 
off when not in use. If the 
device is not able to join the 
network after a reasonable 
period of time, the following 
reasons are possible: 
■ There are no 

communication paths 
available.

■ No WirelessHART network 
has been set up so far.

■ The network ID/join key is 
not correct.

■ Add a WirelessHART 
device which is within the 
antenna range of the 
affected device and try 
joining the network again.
Change the position of the 
affected device and try 
joining the network again.

■ Install a WirelessHART 
gateway first. Set up a 
WirelessHART network. 

■ Check network ID and join 
key.

LED off "Standby" mode: The receiver 
is switched off. The join mode 
is set to "Do not attempt to 
join" or the receiver is in fault.

■ If you want the device to 
try joining the network 
again, make sure that the 
Join Mode parameter is 
not set to "Do not attempt 
to join" (see chapter 5.4). 

■ If you think the receiver is 
damaged, please contact 
Pepperl+Fuchs. 

Red LED (device status)
State Possible cause Action(s)
LED on Internal Fault: An internal fault 

condition has been identified 
(e.g. damaged A/D converter, 
microprocessor, CJC, radio)

Send the device back to the 
manufacturer.

LED flashes at 1 Hz External Fault: An sensor 
burnout has been detected.

Check the sensor and the 
sensor's wires and 
connections to the device.

LED flashes at 3 Hz while 
button A is pressed

Information: Device is 
disconnecting from the 
network before switching itself 
off.

Release button A. The device 
will switch itself off.

LED off There is no error. none

Yellow LED (communication status)
State Possible cause Action(s)
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8.2 Wireless Communication Faults
Fault Possible Cause(s) Corrective Action(s)
PACTwareTM 
cannot find the 
device when 
communicating 
via 
WirelessHART 
Gateway.

The device has not yet joined the 
network.

The joining process may take a 
while. Check the join status in the 
gateway's Instrument List. 
Alternatively, check the wireless 
communication parameters (join 
status) of the device via a HART 
modem connected to the device. If 
the device does not join, check the 
next fault.

The device carries the wrong 
Network ID and/or Join Key.

Check the wireless communication 
parameters of the device via a HART 
modem connected to the device. 
The device and the gateway must 
have the same Network ID and Join 
Key.

The device does 
not join the 
network.

No battery or low battery Check that a fresh battery of the 
correct type is inserted.

The device carries the wrong 
Network ID and/or Join Key.

Check the wireless communication 
parameters of the device via a HART 
modem connected to the device. 
The device and the gateway must 
have the same Network ID and Join 
Key.

No neighboring WirelessHART 
devices are within the device's 
antenna range.

■ Check the number of neighbors 
in the device DTM (wireless 
communication parameters). 
There should be at least 2 
neighbors.

■ If there are no reachable 
neighbors, check the device's 
mounting position: Are there any 
obstacles? If yes, change the 
mounting position.

■ If there are no reachable 
neighbors and you can not 
change the device's mounting 
position: Try moving an other 
WirelessHART device in the 
network, or adding a new one.

Device not mounted correctly Check that the device has been 
mounted correctly. See chapter 3.1

Device not trying to join Check whether the device is trying to 
join the network (LEDs): if not, start a 
new connection attempt by pressing 
the correct button. See chapter 6

Device 
disappears 
sporadically from 
the network

There are not enough neighboring 
WirelessHART devices within the 
antenna range of the device.

Check the number of neighbors in 
the device DTM (wireless 
communication parameters). There 
should be at least 2 neighbors.
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8.3 Wired Communication Faults
Fault Possible cause Corrective action
PACTware cannot 
find the device 
when 
communicating 
via a HART 
modem.

The wrong COM port has been set in 
the HART communication DTM.

Check to which COM port your 
HART modem is connected to. See 
chapter 4.3
Then set the correct COM port in the 
HART communication DTM. See 
chapter 4.5.2

For USB HART modems: Maybe you 
are using a different USB port than 
during setup. The COM port may be 
different if the modem is is plugged 
into a different USB port.

■ Plug the HART modem into the 
correct UBS port.

■ Alternatively, adjust the COM 
port setting in the HART 
communication DTM. See 
chapter 4.5.2

The wrong address range has been 
set in the HART communication 
DTM

Adjust the address range. See 
chapter 4.5.2
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9 Technical Specifications
9.1 WHA-UT-F7B1-0-PP-Z1-EX2

Supply
Rated voltage 3.6 V DC , battery operated
Life span 5 year lithium battery
Power loss/power 
consumption

< 0.09 W

Input
Number of channels 2
Connection terminals 1, 2, 3, 4
RTD type Pt100, Pt1000 (IEC 751: 1995; GOST: alpha = 0.391)

Connection 2-wire: 2 sensors, 3- or 4-wire: 1 sensor
Lead resistance max. 10 
Measuring circuit monitoring sensor breakage
Measurement range Pt100: -200 ... 850 °C

Pt1000:
Thermocouples type E, J, K, T (IEC 584-1)

Cold junction compensation internal , external
Measuring circuit monitoring sensor breakage
Measurement range type K: -270 ... 1370 °C

type T: -270 ... 400 °C
type E: -270 ... 1000 °C
type J: -210 ... 1200 °C

Resistor
Measurement range 0 ... 500  , 0 ... 4000 

Voltage mV Input
Measurement range -100 ... 100 mV , 0 ... 300 mV

Input resistance  1 M

Output
Interface internal antenna
Output variables PV: input 1 (°C, , mV)

SV: input 2 (°C, , mV)
TV: CJC temperature (°C)
estimated battery life (days)
battery voltage (volts)
residual battery capacity (%)

Communication WirelessHART specifications
- physical layer: IEEE 802.15.4.2006
- frequency band: 2.4 GHz (ISM band, licence free)
- transmission rate: 250 kBit/s
- max. transmit power: +10 dBm (EIRP)
- transmission range: outdoor 250 m, indoor 50 m (under 
reference conditions)
- communication standard: WirelessHART
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Transfer characteristics
Temperature measuring range sensor type:

- TC type E: -200 ... 1000 °C, accuracy ± 0,5 °C
- TC type J: -200 ... 750 °C, accuracy ± 1 °C
- TC type T: -200 ... 400 °C, accuracy ± 1 °C
- TC type K: -140 ... 1300 °C, accuracy ± 1 °C
- RTD type Pt100: -200 ... 850 °C, accuracy ± 0,5 °C
- 100 mV, accuracy ± 20 µV
- 300 mV, accuracy ± 40 µV

Accuracy - internal cold junction compensation error ± 1,5 °C (typ. acc. 
to IEC 61298-3)
- external cold junction compensation error ± 1°C (typ.)
- resolution error < 0.1 °C
- accuracy TC ± 20 µV
- accuracy RTD: ± 100 m

Indicators/settings
Display elements LED PWR (battery status), one green LED

LED COM (communication status), one yellow LED
LED FLT (fault signal), one red LED

Control elements 2 push buttons:
- power On/Off
- Join Trigger
- Device Status Trigger
- 2-wire RTD Wire Compensation
- battery replacement confirmation

Configuration wired interface:
- HART 7.1, FSK compatible
- transmission rate: 1200 Bit/s
- used for device commissioning with an handheld terminal or 
a configuration tool (DTM)

Parameter assignment - sampling period: 1, 2, 5, 10, 30 seconds or 1, 2, 5, 10, 30, 60 
minutes
- transmit power: configurable 0 dBm or 10 dBm (EIRP)
- sensor type
- mapping of input measuring values 1 and 2 into primary 
variable (PV) and secondary variable (SV)
- publishing of up to three messages from the device, 
transmission rate selectable from 4 seconds to 60 minutes

Directive conformity
Electromagnetic compatibility

Directive 2004/108/EC EN 61326-1:2006
Radio and telecommunication 
terminal equipment

Directive 99/5/EC ETSI EN 300328: V1.7.1 (2006-10), ETSI EN 301489-17: 
V1.2.1 (2002-08), EN 60950:2001

FCC CFR47 Part 15 B and C ANSI C63.4-2003
Conformity
Degree of protection IEC 60529
Shock resistance EN 60068-2-27
Vibration resistance EN 60068-2-6
Accuracy IEC 61298-3
Ambient conditions
Ambient temperature -20 ... 60 °C (-4 ... 140 °F)
Storage temperature -20 ... 70 °C (-4 ... 158 °F)
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Relative humidity 5 ... 95 %, noncondensing
Corrosion resistance acc. to ISA-S71.04-1985, severity level G3

test setup and execution acc. to EN 60068-2-60
Mechanical specifications
Housing width 129 mm
Housing height 177 mm
Housing depth 77 mm
Degree of protection IP65
Mass approx. 1000 g
Dimensions 77 x 129 x 177 mm (3 x 5.08 x 6.97 in)
Mounting panel or pole mounting
Data for application in connection with Ex-areas
EC-Type Examination 
Certificate

IMQ 09 ATEX 008X

Group, category, type of 
protection  II 2(1)G Ex ia [ia] IIC T4
Directive conformity

Directive 94/9/EC EN 60079-0:2006, EN 60079-11:2007, EN 60079-26:2007
International approvals
FM  approval CoC 3042534
IECEx approval IECEx INE 09.0025X

Approved for Ex ia IIC T4
General information
Supplementary information EC-Type Examination Certificate, Statement of Conformity, 

Declaration of Conformity, Attestation of Conformity and 
instructions have to be observed where applicable. For 
information see www.pepperl-fuchs.com.

Accessories
Designation battery W-BAT-B1-Li mandatory for use in connection with 

hazardous areas (order separately)
Mounting set W-ACC-F7MK
External cold junction compensation W-ACC-CJC
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9.2 Telecommunication Compliance
■ ETSI (R&TTE)
■ FCC Part 15.247 for wireless applications in the area of 2.4 GHz
■ EN 300 328

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions 
allow usage of this product before commissioning.

9.3 Dimensions

Country Guideline
Bulgaria General authorization required for outdoor use 

and public service.
Italy If used outside of own premises, general 

authorization is required.
Japan The device is granted pursuant to the 

Japanese Radio Law and the Japanese 
Telecommunications Business Law.
The device must not be modified (otherwise 
the granted designation number will become 
invalid).

Latvia The outdoor usage of the 2.4 GHz band 
requires an authorization from the Electronic 
Communications Office.

Norway May be restricted in the geographical area 
within a radius of 20 km from the center of Ny-
Alesund.

Rumania Use on a secondary basis. Individual license 
required.
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